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Compliance Information

Compliance Information
This section lists the environmental standards with which the instrument complies.

Environmental Considerations
This section provides information about the environmental impact of the product.

Product End-of-Life Handling
Observe the following guidelines when recycling an instrument or component:

Equipment Recycling. Production of this equipment (the hardware key) required the extraction and use of natural
resources. The equipment may contain substances that could be harmful to the environment or human health if improperly
handled at the product’s end of life. To avoid release of such substances into the environment and to reduce the use of
natural resources, we encourage you to recycle this product in an appropriate system that will ensure that most of the
materials are reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according
to Directives 2002/96/EC and 2006/66/EC on waste electrical and electronic equipment (WEEE) and
batteries. For information about recycling options, check the Support/Service section of the Tektronix Web
site (www.tektronix.com).
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Preface

Preface
IConnect® and MeasureXtractor™ is TDR (time domain reflectometry) software that provides high-speed interconnect
characterization. It is an integrated tool for measurement, compliance testing, modeling and validation for interconnects in
printed and flexible circuit boards, packages, ATE sockets, connectors, cables, and cable assemblies. IConnect provides
accurate measurements and equivalent circuit models that predict reflections, ringing, and crosstalk in interconnects.

This software supports signal acquisition from the following instruments:

Tektronix: DSA8300 (recommended), DSA8200, CSA8000, CSA8000B, CSA8200, TDS8000, TDS8000B, and TDS8200

Key Features
Optimized for use with the Tektronix DSA8300 Digital Serial Analyzer sampling oscilloscope with 80E10, 80E08 and
80E04 true differential TDR modules

Single-click solution for PCI Express, Serial ATA, and HDMI manufacturing and standard compliance testing (including
eye mask tests)

Analyze interconnect jitter, losses, crosstalk, reflections, and ringing concurrently in time and frequency domains

Perform interconnect link analysis to verify system level simulation accuracy

Model PCBs, flexboards, connectors, cables, packages, and sockets

Generate Eye Diagrams with optional aggressors, periodic jitter insertion, and random jitter and noise insertion

Convert TDR/T data into SPICE with MeasureXtractor; model passivity, stability, and causality guaranteed

Obtain S-parameters (differential, single ended, mixed-mode; insertion, return loss, frequency domain crosstalk) using
your TDR oscilloscope

Simple calibration procedure minimizes human errors and makes fixture de-embedding a simple task

Obtain more accurate impedance measurements (Z-Line)

Automate manufacturing test and R&D measurements with scripts and programmatic control command line interface

Documentation
This manual provides installation, basic operation, and application example instructions for the IConnect® and
MeasureXtractor™ TDR Software. For more detailed information, see the online help (Help > Help Contents).
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Conventions Used in This Manual
The following icon is used in this manual:

Sequence
Step
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Installation

Installation

IConnect Software Versions
IConnect is available in the following versions:

IConnect Evaluation: A free and fully functional evaluation version with a limited number of uses and limited time
window of operation

IConnect and MeasureXtractor: Includes all application features (MeasureXtractor, modeling, S-parameters, Z-Line, Eye
Diagram Viewer, standards compliance testing and more)

IConnect w/o MeasureXtractor: Includes all application features except MeasureXtractor

IConnect S-Parameters and Z-Line: Provides S-parameter and Z-Line functions

Minimum System Requirements
Microsoft Windows 7 Ultimate (32- and 64-bit) or XP on supported Tektronix oscilloscopes or a PC

TekVISA software (to run the S-parameter Wizard tool or to communicate with an oscilloscope over a local area network
(LAN)

National Instruments GPIB board or a USB to GPIB adaptor (not required when running IConnect on supported Tektronix
oscilloscopes or over a LAN connection from a Windows PC to a supported Tektronix oscilloscope)

External 1024 x 768 resolution monitor when running on any Tektronix sampling oscilloscope other than the DSA8300

Installing Software
IConnect Software
See the installation instructions that came with the IConnect software CD (071-2676-XX). You can download this file from the
Tektronix Web site (www.tek.com/manuals).

TekVISA Software
If you plan to run IConnect on a PC and acquire waveforms from an oscilloscope connected to a LAN, or run the S-parameter
Wizard function (on the oscilloscope or remotely from a PC), you must install TekVISA software on your PC.

NOTE. TekVISA is already installed on Tektronix DSA8300 oscilloscopes. Legacy Tektronix sampling oscilloscopes
(DSA8200 series and earlier) will need to have the specified version of TekVISA installed to correctly operate with this
release of IConnect.

1. Check which version of TekVISA is installed on your oscilloscope and PC (open the TekVISA tool and click Help
> About). If the version is earlier than 3.3.4.6, go to the Tektronix Web site (www.tektronix.com/software), search
for tekvisa, and download version 3.3.4.6.

2. Follow the installation instructions provided with the TekVISA download file.

IConnect® and MeasureXtractor™ Quick Start User Manual 1



Installation

Starting and Stopping the Application
1. Before starting IConnect, plug the

hardware key into the appropriate USB
or parallel port on your computer. If
you already have a peripheral device
connected to your parallel port, plug the
IConnect hardware key into the parallel
port, and plug the peripheral device into
the back of the IConnect hardware key.

2. Click Start > Programs Tektronix
Applications > IConnect and
MeasureXtractor > IConnect and
MeasureXtractor to start IConnect:

3. To stop IConnect, click File > Exit or the
window Close button. If you have any
unsaved viewers, IConnect prompts you
to save the views before closing.

NOTE. If you open other applications from within IConnect, such as the S-Parameter Wizard, closing IConnect does not
close those applications.

Running IConnect on a Tektronix Oscilloscope
You can install and run IConnect on a supported Tektronix oscilloscope. Running IConnect on an oscilloscope makes it
unnecessary to use a separate PC with a GPIB card, keeping your benchtop area less cluttered.

To most effectively run IConnect on legacy Tektronix sampling oscilloscopes (models earlier than the DSA8300), connect
an external 1024 x 768 resolution monitor to the oscilloscope. The external monitor lets you view all of the IConnect user
interface, while the instrument display shows the application software. See your oscilloscope documentation for help on
setting up dual monitor support.

NOTE. You do not need theTekVISA software to run IConnect on a separate PC that is connected to an oscilloscope directly
through a GPIB interface card. However, you do need TekVISA to remotely operate IConnect over a local area network
or to run the S-parameter Wizard.
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Installation

Running IConnect on a PC
You can install and run IConnect on a PC and communicate with an oscilloscope using a GPIB card installed on the PC,
a USB/GPIB adapter, or a LAN connection.

LAN Interface
Use the following steps to set up communications between IConnect on a PC and an oscilloscope connected to a local
area network (LAN):

NOTE. You must install TekVISA on your PC, and both the instrument and the PC must have a working connection to the
LAN, before doing this procedure.

The following instructions are written for TekVISA version 3.3.4.6. You can download TekVISA from the Tektronix Web site.

1. On the oscilloscope, click the VXI-11 server icon in the system tray and selectStart VXI-11 Server to enable the
VXI-11 server.

2. On the oscilloscope desktop, right-click the My Computer icon and select Properties. Click the Computer Name tab
and write down the full name of the oscilloscope computer.

3. On the PC, right-click the TekVISA icon in the system tray and select Instrument Manager.

4. Click Search Criteria and click the Local LAN bar in the Search Criteria tool.

5. Click the Search Remote LAN check box and enter the oscilloscope computer name to the Add LAN Search Location
field (from step 2). Click the down arrow to add this name to the search list.

6. Click Search for Selected and click Done to close the applet. The instrument you just added should be listed in the
Instruments field on the main TekVISA Instrument Manager page.

7. Select the instrument you just added in this list and click Properties.

8. Enter GPIB8::1::INSTR in the Device Name field type and click OK.

NOTE. This is the default Tektronix oscilloscope GPIB address. If the oscilloscope GPIB address was changed from
the default, enter the correct oscilloscope GPIB address.

9. Start IConnect on the PC. Click the Waveform Acquisition toolbar button and select Tektronix DSA/TDS/CSA8xxx
Local. This should connect IConnect to the specified instrument.

NOTE. The VXI-11 LAN connection also provides a mechanism with which to send GPIB commands from a PC to a
Tektronix oscilloscope. This virtual GPIB connection works as well as a real (physical GPIB card and cable) GPIB connection.

GPIB Card Interface
Install any VISA drivers that are required by the GPIB controller board installed in the PC.

Check the index number of the GPIB board installed in the PC that is running IConnect. If the GPIB board index
number is not GPIB0, change the default IConnect GPIB board setting to match that of the GPIB board. (See page 18,
Acquiring, Saving, and Loading Waveforms.)
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Installation

Set the oscilloscope to online mode. If the oscilloscope is not in the online mode (is set to local mode), the oscilloscope
ignores commands transmitted over the GPIB bus. See the oscilloscope user manual for details on setting the online
mode.

Set or verify that the oscilloscope is in talk/listen mode to enable two-way communication between the oscilloscope
and the GPIB controller.

Set the IConnect GPIB address to match that of the oscilloscope. (See page 18, Acquiring, Saving, and Loading
Waveforms.) Any address between 0 and 31 is valid, although 0 is discouraged it is the default address of most GPIB
controllers. IConnect has default values of 1 for Tektronix instruments. Change this value in IConnect to match your
GPIB and equipment configuration.

USB to GPIB Adapters
A USB to GPIB adapter enables a PC to communicate with a GPIB device. Follow the installation and operation instructions
that came with the USB to GPIB adapter. The adapter must support the IEEE 488.2 specification. The USB to GPIB interface
should be transparent, with IConnect communicating with the oscilloscope using normal GPIB commands.
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Operating Basics

Operating Basics

The User Interface
1. Menu Bar.

2. Toolbar. (See page 5, The Toolbar.)

3. Waveform/Data Views. (See page 6,
The Waveform/Data Views.)

4. Cursor View. (See page 9, Cursors and
Cursor Readouts.)

5. Status Bar. (See page 10, The Status
Bar.)

6. Task Tabs. (See page 9, The Task Tabs.)

The Toolbar
The Toolbar provides one-click access to common operations. Click View > Toolbars and select the toolbar elements to
display.

The Standard toolbar buttons control common application operations
including opening a new view or model window, open or save a file, cut
and copy tasks, print, and undo.

The Auxiliary toolbar buttons provide the following functions:

Opens task tabs with which you can acquire or load waveforms

Performs specific measurements or computations

Captures screen images to a file, clipboard, or printer

The Algorithm toolbar buttons. The S and Z buttons provide fast
access to parameters and actions to compute S-parameter and Z-Line
measurements.

IConnect® and MeasureXtractor™ Quick Start User Manual 5



Operating Basics

The Enhanced Accuracy toolbar buttons. The EAC 1 button runs
the Enhanced Accuracy Characterization command (on DSA8200
oscilloscopes) for improved long-record accuracy.

NOTE. The DSA8300 acquisition hardware does not require the IConnect
EAC function.

The Compensate Oscilloscope 2 button runs the temperature
compensation function of the oscilloscope for improved long record
waveform measurement accuracy. (See page 12, Measurement Best
Practices.)

The S-parameter Wizard button provides a graphical interface and
procedure guidance to automatically acquire TDR and TDT waveforms
from a DUT connected to a Tektronix sampling oscilloscope to calculate and
generate S-parameter and Touchstone files. (See page 38, Automatically
Creating S-Parameter Files (S-Parameter Wizard).)

The Viewers toolbar buttons. The Eye Diagram button opens the Eye
Diagram viewer for setting up and displaying Eye Diagrams. The EZ
button opens the EZ Z-Line viewer for creating and comparing Z-Line
measurements against a known DUT reference.

The Model toolbar buttons open model viewers to extract a variety of
interconnect models from measurement data for use in design simulation
and validation. (See page 49, Advanced Modeling (MeasureXtractor™).)

1 IConnect checks the oscilloscope thermal compensation status when you run the EAC function. If the oscilloscope or any module is not
compensated, IConnect initiates the oscilloscope compensation program, and then runs the oscilloscope EAC program. If the oscilloscope and all
modules are compensated, IConnect just runs the oscilloscope EAC program.

2 The Compensate Oscilloscope button runs the compensation program regardless of the current compensation status of the oscilloscope.

The Waveform/Data Views

The Waveform/Data views show acquired
and calculated waveform and data traces
and a list of the waveforms in the viewer.
The type of waveform trace or data shown
depends on the selected operation. If there
are multiple views available, each view is
accessed with a separate tab.
The icons to the left of the file names identify
the waveform type:

V: Voltage

Z: Impedance

S: S-parameter

?: Unknown
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Operating Basics

Waveform trace operations. A waveform trace is a plot of a measurement waveform or a data waveform calculated
by IConnect based on measurement waveforms. The following table lists the operations that you can do on a selected
waveform trace:

Operation Description
Select a waveform Click a waveform to select it. You can also select a waveform by clicking on the

waveform name in the Legend tab for that view. Selecting a waveform sets the
display to show the vertical scale and units of the selected waveform.

Move a waveform Click and drag a waveform to move it.
Save a new waveform or an existing
waveform to a new name and/or
location

Right-click a selected waveform and select Save As. Navigate to where you want
to save the file, and enter a new file name if required.

Export waveform data to a different
format

Right-click a selected waveform and select Export. Navigate to where you want
to save the file, enter a new file name if required, and select the type of file to
save to. Available export formats depend on the selected waveform.

Delete a waveform from the view Right-click a selected waveform and select Delete. You can also select a
waveform and press the keyboard Delete key. Use the Undo button on the
Toolbar to restore deleted waveforms.

Show or remove a cursor readout for
the selected waveform

Right-click a selected waveform and select Cursor Readout. A check mark
indicates that the cursor readouts are enabled for the selected waveform. Select
Cursor Readout again to remove the cursor readout.

Create a label to associate with a
specific waveform

Right-click a selected waveform and select Label to create a default label with the
waveform name. Click and drag a label to move it. Right-click on a label to edit
the label text, size, color, and other properties. A label does not move when you
move its associated waveform.

Hide a waveform Right-click a selected waveform and select Hide to remove the waveform from
the waveform view (the waveform remains in the Legend list). The application
can still access hidden waveforms to perform calculations. To restore a hidden
waveform, right-click the waveform in the Legend list and select Unhide.

Reset a waveform position Right-click a selected waveform and select Reset Position to reset the waveform
to its original position when acquired.

Align one DUT waveform with another
DUT waveform (EZ Z-Line function)

Right-click a selected waveform and select Adjust to Position. The Adjust to
Position feature lets you align one DUT TDR waveform plot with another DUT plot
to provide a more accurate comparison of their Z-Line plots.

Apply a predefined low pass filter and
recalculate a waveform

Right-click a selected waveform and select Filter (n). The value of n is set in the
Computation tab, with the compute type set to Filter Waveform.

Display a waveform in a Spectrum
view

Right-click a selected waveform and select Spectrum.

Change the color and other properties
of a waveform

Right-click a selected waveform and select Properties to change the waveform
color, add comment text, hide or unhide the waveform, or enable or disable
cursor readouts.

Convert a S-Parameter waveform
to an impedance versus frequency
waveform

Right-click a reflected waveform and select Impedance. IConnect opens a new
FD Waveform Viewer showing the impedance versus frequency plot.

NOTE. You should only do a S-Parameter to impedance versus frequency
conversion on reflection (return loss) S-Parameter waveforms. Reflection
waveforms are typically named S11, S22, S33, and so on. Doing a conversion on
a nonreflection waveform generates invalid results.
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Waveform view operations. Waveform View operations apply to the entire waveform plot area, and are accessible by
right-clicking inside a waveform view when no waveform traces are selected. The following table lists the operations that
you can do to the waveform view:

Operation Description
Zoom in on a specific region of the
view

Click and drag in a view to zoom in on that region.

Set the horizontal and vertical
scales to show all waveform traces
(Autoscale)

Right-click in a waveform view and select Autoscale.

Undo zoom operations to see the
waveform trace as defined by the
current scaling, whether set manually
or by Autoscale

Right-click in a waveform view and select Zoom to 100%.

Set the horizontal and vertical scales
for the waveform view

Right-click in a waveform view and select Set Scale. Enter the horizontal and
vertical limits of the graph.

Create a label to save with the
waveform view

Right-click in the waveform view, select Label, and enter the label text. Click and
drag a label to move it. Right-click on a label to edit the label text, size, color,
and other properties.

Import waveform or other data into a
view

Right-click in a waveform view and select Import. Select the type of data to
import, then navigate to and select the file to import.

Change the waveform plot units Right-click in a waveform view and select Plot. Select the type of plot and set
other parameters as needed. The available plot types depend on the waveform
view (waveform traces or spectrum view).

Export the waveform view data to a
Touchstone format file

Right-click in the waveform view and select Export > Touchstone, and specify
the port type. Navigate to where you want to save the Touchstone file and enter a
new file name if required. The available file options (based on the port numbers)
depend on the number of the S-parameter waveforms.
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The Task Tabs

The task tabs provide access to parameters
and actions for acquiring waveforms or
setting measurement parameters. Click the
Auxiliary or Algorithm toolbar buttons to open
associated Task tabs.
Click a tab to show the parameters for that
tab. Task tab contents change depending on
the selected measurement or operation.
You can undock a task tab from the main
window by clicking and dragging on the
double-line area at the top of the tabs to
move that tab away form the main application
window.

Cursors and Cursor Readouts
Cursors provide a way to take measurements at a specific point on a waveform. The cursor readouts show the waveform
values at the cursor position.

1. Click and drag a cursor to move it. The
two vertical cursors (colored red and
blue) let you take measurements at two
points on one or more waveforms.
You can also use the keyboard arrow
keys to move a waveform, and Ctrl+ the
arrow keys for fine movements.

2. Look at the Cursor readouts to see the
horizontal and vertical values at the
cursor positions for each waveform and
the difference (delta) value between
the cursors for each waveform. The
measurement units depend on the View
plot type.

3. To enable a cursor readout for a
waveform, right-click a waveform and
select Cursor Readout. (See page 7,
Waveform trace operations.)
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The Status Bar

The Status Bar shows the status of the
current operation and displays help text
associated with the button, field, or area at
the current mouse cursor position.
Rolling the cursor over an interface element
displays a pop-up description of that item,
and more detailed information in the Status
bar.

Connecting the DUT
Follow the procedures in your oscilloscope manual (and any associated TDR module or probe manuals) to correctly
connect the test cables, test fixture (if used) and DUT to the oscilloscope. Use electrostatic handling precautions when
initially connecting and while taking TDR measurements, as the TDR measurement modules are extremely susceptible to
electrostatic damage. Follow the oscilloscope procedures to deskew the test cables for accurate TDR/T measurements.

Typical Measurement Setups
1-Port Single-Ended

2-Port Single-Ended
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4-Port Single-Ended

1-Port Differential

2-Port Differential

NOTE. In the 4-Port Single-Ended mode, Full Thru calibration improves the phase accuracy on the crosstalk measurements
by measuring a Thru reference for each of the six TDT paths, in both directions. This creates twelve reference thru
waveforms in all.

Making good connections to the device under test.

CAUTION. Circuitry in the sampling module is very susceptible to damage from electrostatic discharge or from overdrive
signals. To prevent electrostatic damage to the main instrument and sampling modules, follow the precautions described
in the manuals accompanying your oscilloscope. Be sure to only operate the sampling module in a static-controlled
environment. Be sure to discharge the center and outer connectors of cables to ground before attaching the cable to
the sampling module.

Good connections to the DUT are critical to achieve high quality measurements. Using high-quality, low-loss microwave grade
cables and probes enable the oscilloscope to deliver full incident rise time to the DUT. Since the minimum discontinuity that
can be resolved by a TDR step must be separated from the discontinuity next to it by about one-half the observed rise time,
delivering a faster rise time to the DUT lets IConnect resolve smaller DUT sizes or achieve higher measurement resolution.
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Use the following guidelines when connecting the DUT to cables, probes, and/or a fixture:

Use high-quality, low-loss microwave grade cables or probes. Generic cables such as RG-58 are rather stiff and the
delay (therefore phase) varies considerably when the cable is flexed.

Make sure that module connectors are clean. Clean connectors with a swab moistened with isopropyl alcohol if needed.
Allow the connector to dry completely before using.

Use a torque wrench on connections.

When using a barrel, use the correct wrench to hold the barrel while tightening the connectors.

Use high-quality reference standards. For best insertion loss accuracy, use a Thru reference. For best return loss
accuracy, use an Open or Short, with a Load reference.

When the DUT requires a fixture, make sure that the fixture has a low-inductance, low-resistance ground return path to
the oscilloscope to provide the cleanest measurement interface.

Measurement Best Practices
Taking accurate measurements is the most important element in measurement-based modeling. Without accurate
measurements, skilled modeling and thorough verification are a waste of time. The following tips will help you to take
accurate measurements.

Warm Up the Oscilloscope
A Time Domain Reflectometry (TDR) oscilloscope is a high-performance, high-accuracy instrument. To fully use the accuracy
and precision of the instrument, allow the instrument to warm up for 20-30 minutes before performing any measurements,
to allow its temperature to stabilize. The oscilloscope manual may provide exact specifications on warm-up times for
your particular instrument. You should also keep the air temperature of the instrument environment as stable as possible
during measurement sessions.

Compensate the Oscilloscope
Compensation optimizes the capability of the instrument to make accurate measurements at the ambient temperature. Click
the Compensate Oscilloscope button to run the compensation program on supported Tektronix oscilloscopes. To run
compensation on other oscilloscope models, see the oscilloscope user documentation.

Enhanced Accuracy Measurements
Enhanced Accuracy is a function on supported Tektronix oscilloscopes that improves measurement accuracy of long record
length acquisitions. Click the EAC button to run the EAC program on supported Tektronix oscilloscopes (DSA8200 Series
with serial number B030000 and above, or DSA8200 Series with the DSA82EFEUP (Electrical Front End board) upgrade).

NOTE. The DSA8300 acquisition hardware does not require the IConnect Enhanced Accuracy (EAC) mode.
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Observe Electrostatic Discharge Prevention Guidelines
Circuitry in the sampling module is very susceptible to damage from electrostatic discharge or from overdrive signals. To
prevent electrostatic damage to the main instrument and sampling modules, follow the precautions described in the manuals
accompanying your oscilloscope. Be sure to only operate the sampling module in a static-controlled environment. Be sure to
discharge the center and outer connectors of cables to ground before attaching the cable to the sampling module.

Deskew the Oscilloscope Channels and Test Cables
Deskew the channels in the TDR oscilloscope when taking differential measurements (for coupled models). Follow your
oscilloscope deskewing procedure before acquiring differential data.

Use Signal Averaging
Use signal averaging with the oscilloscope to reduce noise. 128 averages can provide an extra 20 dB of dynamic range.

Display the Correct TDR Waveform Information
To take useful TDR measurements for model extraction in IConnect, it is necessary to remove the incident transition from the
displayed TDR waveform. (See page 13, Displaying the Correct TDR Waveform.)

Capture an Adequate Length Waveform Data Record
Capture all the transitions in the reflection or transmission waveform that characterize the DUT. In many cases this includes
the low-frequency asymptote, which means that the waveform must settle to an appropriate level:

To 0 V for short termination

To the full incident step amplitude for an open termination

To exactly half the incident step amplitude for a matched, or 50 Ω termination

If the measurement window stops before the waveform has settled, the resulting measurements and modeling may be
inaccurate. For more information on TDR-based interconnect modeling and basics of TDR, download the IConnect TDR
Software Modeling Quick Guide from the Tektronix Web site.

Displaying the Correct TDR Waveform
IConnect requires just the reflected part of the TDR waveform for making measurements. Adjust the oscilloscope to remove
the incident waveform step from the displayed waveform. There are two ways to remove the incident step; use the Autoset
TDR function on supported Tektronix oscilloscopes, or manually set the waveform display to remove the incident step.

Auto Setup of TDR Waveforms (Tektronix 8000 Series Sampling Oscilloscopes)
Prerequisites:

Let the oscilloscope warm up at least 20 minutes, or until it has passed its warm-up compensation test, before taking
measurements.

(Optional) To achieve maximum measurement accuracy, after instrument warm-up, click the Compensation button to
open the Compensation dialog box and execute compensation on the mainframe and TDR modules.
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1. Connect cables and fixtures to the
oscilloscope using safe antistatic
handling practices. Do not connect the
DUT.

2. On the oscilloscope, press the Setup
Dialogs button.

3. Click the TDR tab.

4. In the Preset settings, click the channels
to use for your TDR measurements. For
Differential measurements, click the Diff
button for each pair of channels used.

5. In the TDR Step settings, enable
measurement channels and set the step
pulse polarity.

6. In the ACQ settings, enable
measurement channels and set
the units to V for each channel taking a
TDR measurement.

7. Click the Advanced TDR Setup button
(TDR Autoset Properties button for
legacy oscilloscopes).
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8. (DSA8300) Set the TDR Step Rate,
10 MHz Reference source, and Autoset
Options fields as shown in the Autoset
Properties dialog box. Click Close.

(DSA8200 and other legacy
oscilloscopes) Set the Mode, Options,
and TDR Options fields as shown in
the Autoset Properties dialog box. Click
Close.

9. Press the Autoset front panel button to
acquire and display the TDR waveform.
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10. Use the Horizontal POSITION knob to
move the waveform to near the left edge
of the screen.

11. Right-click the Reference icon and
select Left to move it to the left side of
the screen.

12. Connect the DUT to the text fixture.

13. Make sure that the DUT reflection step
is on screen.

14. The waveform record length should be
two to three times as long as the distance
from the left screen edge to the DUT
reflection step, to accurately capture
the required data. Use the Horizontal
SCALE knob to set this if necessary.
You are now ready for IConnect
to acquire waveforms from the
oscilloscope.
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Manual Setup of TDR Waveforms

1. Connect cables and fixtures to the
oscilloscope using safe antistatic
handling practices. Do not connect the
DUT.

2. Set the oscilloscope to take TDR
measurements. Adjust the oscilloscope
to display both the incident and reflection
steps of the TDR waveform.

3. Adjust the oscilloscope to position the
incident step off-screen and the reflection
step waveform edge near the left edge of
the screen.

4. Position the Reference marker to just
left of the rising edge of the waveform.

5. Connect the DUT.
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6. Ensure that the DUT reflection step is on
screen. Use the Horizontal SCALE knob
to adjust this if necessary.

7. The waveform record length should be
two to three times as long as the distance
from the left screen edge to the DUT
reflection step, to accurately capture
the required data. Use the Horizontal
SCALE knob to adjust this if necessary.

8. Repeat steps 6 and 7 until the waveform
is correct.
You are now ready for IConnect to acquire
waveforms from the oscilloscope.

Acquiring, Saving, and Loading Waveforms
Acquire and Save Waveforms from an Oscilloscope
Use this procedure to acquire waveforms from a connected instrument.

Set the oscilloscope to take the appropriate TDR or TDT measurements before acquiring waveforms in IConnect. (See
page 13, Displaying the Correct TDR Waveform.) Make sure to acquire all necessary waveforms for the IConnect
measurement without changing the timebase on the oscilloscope.

NOTE. If you are taking S-parameter measurements on a Tektronix CSA8200, use the S-parameter Wizard to set up
and acquire the measurements. The S-parameter Wizard automates the waveform setup and acquisition process,
saving significant time and reducing measurement inaccuracies. (See page 38, Automatically Creating S-Parameter
Files (S-Parameter Wizard).)
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1. Set the oscilloscope to display the
correct TDR waveform. (See page 13,
Displaying the Correct TDR Waveform.)

2. In IConnect, click the Waveform
Acquisition button.

3. Click the Measure tab.

4. Select the appropriate instrument from
the Instrument list. If you get a “Could
not allocate” message, the next step
sets up the GPIB connection to the
oscilloscope.

5. If the oscilloscope is being accessed
using a GPIB card, click the Instrument
Settings tab and verify or set the GPIB
parameters, including the GPIB board
index.

6. Select the waveforms or traces to
acquire from the instrument. The
displayed values depend on the selected
oscilloscope.

7. Click the Measure tab and select the
waveform(s) or traces to acquire. Use
standard Microsoft Windows operations
to select multiple waveforms.
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8. If you are using a Tektronix instrument
with long record length capability, you
can set the Use Long Record check box
and click the Long Record Parameters
button to set the long record length
parameters for the acquired signal.
Make sure to increase the Timeout value
when using long records. Long record
lengths are useful when working with
long transmission lines.

9. (Optional) Click the EA Characterize
button to manually run enhanced
measurement accuracy characterization
on supported Tektronix oscilloscopes.
EAC improves long record length
measurement accuracy. The EAC
function checks the oscilloscope
compensation status. If the oscilloscope
or any modules are not compensated,
IConnect runs the oscilloscope
compensation program before running
EAC.

10. Click the Acquire button. IConnect
opens the TD Waveform Viewer window
and displays the acquired waveforms.
You can now use IConnect to analyze or
model the DUT.
The Acquire function also checks the
status of the Tektronix oscilloscope
temperature compensation. If the
oscilloscope is compensated (modules
and mainframe), IConnect runs the EAC
function (on supported oscilloscopes)
and acquires the waveforms. If the
oscilloscope is not compensated,
IConnect displays a dialog box asking if
you want to compensate the oscilloscope
before acquiring waveforms. Click Yes
to compensate the oscilloscope before
acquiring waveforms.

11. To save a waveform to a file, right-click
a selected waveform in the viewer or
Legend list and select Save. Navigate
to where you want to save the file, and
enter a file name.

20 IConnect® and MeasureXtractor™ Quick Start User Manual



Operating Basics

Load Waveforms from Saved Files
Use this procedure to load waveforms that were saved during a previous waveform acquisition session.

1. Select File > Open. Navigate to and
select the file or files to open. Click
Open.

2. IConnect loads the waveforms and
displays the correct viewer for the
waveforms.

Using Drag-and-Drop to Load Waveforms or Files
You can use standard Microsoft Windows drag-and-drop operations to load waveform, model, and waveform viewer files
into IConnect. As you will need adequate room on a display to view both the Windows Explorer and IConnect application
window, this method is recommended only when running IConnect on a PC, or when running IConnect on a Tektronix
oscilloscope to which an external monitor is connected.
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File Operations
File Operation Procedure
Save a single waveform Select the waveform in the plot or Legend tab list. Right-click to open the shortcut

menu and click Save.
Save one or more waveforms to a new
location

Select the waveform(s) in the plot or Legend tab list. Right-click to open the
shortcut menu and click Save As. IConnect sequentially opens a Save As dialog
box, one for each selected waveform. Use normal Windows operations to specify
the location and name for the saved waveform.

Export a waveform to a CSV format
file

Select the waveform in the plot or Legend tab list. Right-click to open the shortcut
menu and click Export. Select CSV. Use normal Windows operations to specify
the location and name for the saved waveform. Select the type of CSV file
(space, comma, or tab-delimited).

Export a waveform to a Touchstone
file

Right-click in the plot to open the shortcut menu and select Export > Touchstone.
Use normal Windows operations to specify the location and name for the saved
waveform. You can only export waveforms to Touchstone that are appropriate
for that format.

Save the oscilloscope settings to a file Click File > Save Instrument Settings. Use normal Windows operations to
specify the location and name for the oscilloscope settings file. You should use
a naming convention to clearly label the file with the oscilloscope to which the
settings apply.

Load (restore) oscilloscope settings
from a file

Click File > Load Instrument Settings. Use normal Windows operations to
locate and select the appropriate oscilloscope settings file. Click OK to load the
settings to the connected oscilloscope.

NOTE. Loading a settings file saved from one oscilloscope into a different type
of oscilloscope will not work, and may cause unpredictable results on the target
oscilloscope.

Execute oscilloscope commands from
a file

You can use a text file to send valid GPIB commands to the instrument. Create
a text file that contains the correct GPIB commands and syntax for the target
oscilloscope. Click File > Load Instrument Settings. Use normal Windows
operations to locate and select the appropriate oscilloscope command file. Click
OK to send the commands to the connected oscilloscope.

NOTE. If the oscilloscope does not respond as expected, and the
communications to the oscilloscope are good, verify that the GPIB command
syntax and values are correct in the command text file.
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Waveform Math
In general, it is better to let the oscilloscope perform waveform math, as the oscilloscope can usually do this math faster.
IConnect can do addition, subtraction, multiplication, and division of two waveforms. It can also do integration, differentiation,
and filtering of a waveform. Since a constant may be substituted for one of the waveforms, waveform math also allows
convenient scaling and offsetting of waveforms.

Waveform math is executed from the computation window by choosing Waveform Math from the Compute list box. Select
the required operator from the Operator drop-down list located in the Waveforms group. Depending on the nature of the
operator, select either one or two operand waveforms in the remaining drop-down list boxes in the group. Click the Compute
button, and the resultant waveform is placed in the selected waveform viewer. To use a constant as one of your operands,
select Constant from one of the waveform selection boxes, and enter the value of the constant in the field at the bottom of
the Computation window.

Integration and Differentiation
Integration is performed as the running sum of the waveform data points, multiplied by the time step between data points.
For this reason, the magnitude of the integrated waveform will typically be several orders of magnitude smaller than that of
the original waveform. Differentiation is performed as the difference between consecutive waveform data points, divided by
the time step between data points. For this reason, the magnitude of the differentiated waveform will typically be several
orders of magnitude larger than that of the original waveform.

NOTE. Differentiation attenuates low-frequency components and amplifies high-frequency components. Therefore, it is not
uncommon for high-frequency noise to be visibly present in a differentiated waveform.
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Eye Diagram Compliance Testing
A compliance test consists of a series of Eye Diagram tests (eye setups) as defined for a standard such as SATA, HDMI, or
PCI Express. Each standard defines the number of Eye Diagram tests and the characteristics of each Eye Diagram that
are required to meet compliance.

Prerequisite:

Compliance test setups (SATA, HDMI, and PCI-Express setups are supplied with IConnect)

Eye Diagram Compliance Test Procedure

Prerequisites
Follow measurement best practices. (See page 12, Measurement Best Practices.)

Set the oscilloscope to display the correct waveforms. (See page 13, Displaying the Correct TDR Waveform.)

Set IConnect to acquire the necessary waveforms. (See page 18, Acquiring, Saving, and Loading Waveforms.)

1. Click the Eye Diagram Viewer button.

2. On the Compliance Test tab, click the
Load Compliance Test button. Navigate
to and select the compliance test file
(*.cts). IConnect lists the eye setup tests
in the Edit Compliance Test area and
loads required masks in the Eye Diagram
viewer.
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3. Connect cables and fixtures to the
oscilloscope. Do not connect the DUT.

4. Select the reference waveform from the
Waveform list.

5. Click the Acquire Reference Wfm
button. IConnect acquires and plots
the reference waveform on the TDR/T
viewer tab.

6. Connect cables, fixtures, and the DUT
to the oscilloscope.

7. Select the transmission waveform from
the Waveform list.

8. Click the Acquire Transmission Wfm
& Run Test button. IConnect acquires
the transmission waveform, runs all eye
tests, and plots the results of the last test
on the Eye Diagram viewer tab.
IConnect first runs theTx tests, then runs
the Rx tests.

9. The Test Status area lists the pass/fail
status of each test, and shows a
color-coded Pass/Fail field to show the
overall test status. The last line of the
test status is the name of the compliance
test that was run.
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10. Select the Eye Diagram viewer tab and
click an item in the Eye Setups list to
show the Eye Diagram plot and the Eye
Measurements (if enabled) for that eye
test.

11. If one or more tests fail, IConnect
displays an error message and shows
which tests failed in the Test Status area
list. You can then select the failed test
item in the Eye Setups list to show the
eye diagram for that test.

12. Click Run Test to run the test again.
Note that the test may fail on occasion
because IConnect applies random
values to some parameters (such as
jitter) to simulate real-signal conditions.

13. To save results, click the Save Results
button. Navigate to and select a directory
in which to store results. IConnect
creates a folder in that directory and
names it with the compliance test name
(as listed in the Name field) appended
with a number (starting with 1).
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NOTE. In the Eye Diagram Options dialog box, the Save as Default button saves the eye setup parameters to the IConnect
registry on the PC. These settings now become the new default settings when you select the New button in the Compliance
Test tab (bottom of the tab, below the Eye Setups list), and is also used in the default New Compliance Eye Setup entry
listed in the Eye Setups field.

The test result folder contains:

A PNG-format screen shot of the entire Eye Diagram viewer, for each eye setup test

A copy of the source .cts file used by that test, but modified by IConnect during runtime for such things as the jitter
insertion parameters for the Rx eye test, which are generated as part of the test run

A text file with overall test results

A text file with the test results for each eye setup
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Creating a Standard-Based Custom Eye Diagram Test
IConnect lets you create custom eye diagram tests based on the application-supplied standards (SATA, HDMI, or
PCI-Express). Each standard defines the number and type of eye diagrams (eye setups) needed to pass the requirements of
that standard.

NOTE. IConnect cannot automatically run all tests in a custom Eye Diagram test setup; you must select a test, click the Test
Eye tab, and click the Display Eye button.

Part of an eye diagram computation is setting up the eye diagram options, such as input sequence, data rate and rise time. If
you are computing an eye diagram without any crosstalk effects, you only need to set parameters for the DUT (victim) line. If
you are including crosstalk effects in your eye diagram, you will need to set parameters for each aggressor line.

1. Click the Eye Diagram button to open a
new Eye Diagram viewer.

2. On the Compliance Test tab, select the
standard against which to test from the
Procedure list.

3. Enter a name for your custom test in the
Name field.

4. Select the New Complete Eye Setup
item in the Eye Setups list. This is a
default eye setup.

5. Click the Define Eye tab.

6. Click the DUT button and use the tabs
and controls on the Eye Diagram
Options dialog box to define the DUT
Eye Diagram parameters such as input
sequence, data rate, jitter, mask test,
and risetime. Click the Help button for
information on the various parameters.
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7. Enter the new name for the eye setup
test in the Eye Setup Name field.

8. Use the Comment field to add additional
information about the eye setup.
Comments can contain up to 30,000
characters.

9. To save an eye setup to a file (*.mts),
click the Save or Save As button and
navigate to a folder and enter the name
of the setup file.

10. Click OK to apply the settings, close the
dialog box, and return to the Define Eye
tab.

11. To add aggressors to the eye setup
test, click the arrow buttons in the
Aggressors field to set the number of
aggressors (up to eight). IConnect adds
a button for each aggressor, which you
click to set the parameters for each
aggressor.

NOTE. If you cannot select the Use check
box next to the Aggressor buttons, then the
aggressor does not have all its required
waveforms loaded on the Legend page.
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12. To add more eye setups to the
compliance test, click the New button
on the Compliance Test tab and enter
the name of the eye setup in the Create
New Setup dialog box. Click the Define
Eye tab and use the controls to define
the DUT and aggressor parameters for
that eye setup.

13. To save the entire test (all eye setup
files) to a single compliance test file
(.cts), click the Save or Save As button
on the Compliance Test tab, navigate
to a folder, and enter the name of the
setup file. IConnect verifies that the test
contains all required eye setups and eye
types, and will not save a file until the
eye setup tests meet the requirements
for the specified standard.

NOTE. You can load a saved eye setup file (*.mts) into your current Eye Diagram test. Click the Load button and navigate to
and select the eye setup file to load.

When Not to Run an Eye Diagram Compliance Test
When the reference or transmission waveform is missing (IConnect requires both)

When the number of eye setups in the test does not match what the selected standard requires

When eye setups do not have the correct eye type or position settings for the selected standard

When the Eye Compliance Test Procedure field has Custom selected (you must select and run each test individually)

Creating Custom Eye Diagram Tests
The eye diagram is a method to visualize a digital data stream, in which each consecutive clock cycle is overlaid on top of the
first cycle in the data stream. The digital data pattern may be switching from 1 to 0, from 0 to 1, or stay at a 1 or 0 level. As a
result, this continuously changing data stream, observed within a single cycle, produces a display resembling a human eye.

Eye diagram calculations require two measurements:

A reference TDR measurement of all connecting cables and/or probes without the DUT, on the positive switching channel.

A transmission TDT waveform on the positive-switching line at the far end of the DUT. Make sure to use exactly the same
time base as for the reference waveform.
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1. Acquire the reference and transmission
waveforms. (See page 18, Acquiring,
Saving, and Loading Waveforms.)

2. Click the Eye button to open the Eye
Diagram Viewer.

.

3. Click the Legend tab.

4. Click the DUT button and load the
reference and transmission waveforms.

5. To add aggressors, click the arrow
buttons in the Aggressors field to set
the number of aggressors (up to eight).
Click each Aggressor button to load the
waveforms for that aggressor (reference,
crosstalk, and optional fixture).

6. Click the Define Eye tab.

7. Click the DUT button and use the fields,
tabs and controls on the DUT Eye
Diagram Options dialog box to define
the Eye Diagram parameters such as
input sequence, data rate, jitter, mask
test, and risetime.
If you have enabled aggressors, click
each aggressor button and use the
Aggressor Eye Diagram Options to set
the aggressor parameters.

8. Enter the name of the eye diagram test
setup in the Eye Setup Name field.

9. Use the Comment field to add additional
information about the eye setup.
Comments can contain up to 30,000
characters.
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10. Click the Save or Save As button in the
Define Eye tab to save the eye diagram
test.

11. Click the Test Eye tab. Set the
parameters on this tab as required for
your eye test.

12. Click the Display Eye button to display
the eye diagram in the viewer. If you
enabled mask, jitter, or noise testing,
the Eye Diagram Test area displays the
pass/fail status of each test.

13. To evaluate different settings with the
same signals, click the Define Eye tab,
click the DUT or Aggressor buttons,
make changes to the test settings, and
click the Apply button. IConnect redraws
the eye diagram based on the new
settings.

EZ Z-Line DUT Testing
The IConnect EZ Z-Line viewer is specifically designed to do quick, single-button Z-Line computation for any number of
device waveforms. The EZ Z-Line viewer lets you:

Measure and store waveforms and instrument settings from a known good device and test cable assembly to create a
Golden Setup file

Use a single-button click to quickly acquire successive device waveforms, generate Z-Line impedance plots, and
compare the device impedance plots against the Golden Setup
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Prerequisites
Follow measurement best practices. (See page 12, Measurement Best Practices.)

Set the oscilloscope to display the correct waveforms. (See page 13, Displaying the Correct TDR Waveform.)

Set IConnect to acquire the necessary waveforms. (See page 18, Acquiring, Saving, and Loading Waveforms.)

Create a Golden Setup File

1. Use a golden DUT to display a correct
TDR waveform. The golden DUT is
a DUT with known good impedance
characteristics. (See page 13, Displaying
the Correct TDR Waveform.)

2. Disconnect the golden DUT.

3. Start IConnect. Establish communication
with the instrument. (See page 18,
Acquiring, Saving, and Loading
Waveforms.)

4. Click the EZ button on the toolbar to
open the EZ Z-Line Viewer.
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5. Select the waveform source from the
Waveform drop-down list.

6. Click Golden Setup.

7. Click Reference to acquire and plot
the reference waveform in the TDR/T
tab. This waveform is labeled Golden
Reference.

8. Reconnect the Golden DUT to the test
cable assembly.
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9. Click DUT to acquire and plot the Golden
DUT waveform in the TDR/T tab. This
waveform is labeled Golden DUT.

10. Set the measurement system impedance
(ZO) and threshold parameters if
required. The default values (50 Ω and
35%) are good for most measurements,
but may need adjusting to accommodate
your test setup.

11. (Optional) Click Comment and enter
comment text in the displayed dialog box.
If the EZ Z-Line Viewer comment field
is empty, the Golden Setup comment
will be copied into it. Otherwise the two
comments are independent.

12. Click Save Golden Setup to save the
Golden Setup file to a specified location
and name. Golden Setup files have the
extension .gst.

Taking DUT Z-Line Measurements with a Golden Setup
Prerequisite. Connect the test cable assembly to the oscilloscope. Make sure to use the same type of test cable
assembly (cable types, lengths, TDR probes, connectors, fixtures, and so on) that was used to create the Golden Setup.
Do not connect the DUT at this time. Make sure that IConnect can communicate with the instrument. (See page 18,
Acquiring, Saving, and Loading Waveforms.)

1. Click the EZ toolbar button to open the
EZ Z-Line Viewer.

2. Click Golden Setup.
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3. Click Load Golden Setup. Navigate
to and select the Golden Setup file that
you want to load. Make sure to load a
Golden Setup file that was created for the
instrument to which you are connected,
and that the same test cable assembly
and instrument settings are being used
to take the current set of measurements.

4. Click OK to close the dialog box and set
IConnect to use this golden setup with
this EZ Z-Line viewer.

5. Disconnect the DUT. Click in the
Waveform list and select the
oscilloscope waveform source or
channel to which the DUT will later be
connected.

6. Click Reference in the DUT Setup
area. IConnect displays a message
asking whether and how to align the
new reference. Click OK to accept
the recommended selection. IConnect
adjusts the instrument settings to
align the waveforms, acquires the new
reference waveform, and plots the new
reference waveform in silver on the
TDR/T tab, with the label Reference.

7. If you are not using a calibration
waveform, select the Do not use 50 Ω
Cal check box.

8. If you are using a calibration waveform,
acquire a new calibration waveform by
connecting a 50 Ω termination to the end
of the test fixture assembly and clicking
50 Ω Cal (opt). IConnect acquires and
plots the new calibration waveform in
silver. Remove the 50 Ω termination.

9. Connect the (nongolden) DUT to the test
fixture assembly.
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10. Click Acquire DUT. IConnect acquires
the DUT waveform and plots it on the
TDR/T and Z-Line tabs. The DUT plot is
labeled DUTn on the TDR/T tab, and Zn
on the Z-Line tab, where n is an integer
that increments for each DUT waveform
acquired.

11. Click the Z-Line tab to compare the DUT
impedance waveform with the GoldenZ
impedance waveform. Determine if the
DUT matches the Golden DUT waveform
characteristics.

12. Disconnect the DUT.

13. Repeat steps 9 through 12 for each
DUT that you want to test and compare
against the Golden DUT. This example
shows that the plot from DUT acquisition
five (labeled Z5 in the figure) does not
match the Golden Z-Line plot.
Repeat steps 6 through 8 (with the DUT
disconnected) at regular intervals during
prolonged DUT testing to acquire a new
reference waveform. Acquiring a new
reference waveform at regular intervals
helps compensate for oscilloscope
measurement drift.
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Automatically Creating S-Parameter Files (S-Parameter Wizard)
The IConnect S-parameter Wizard makes aquiring one-, two-, or four-port S-parameter waveform files fast, easy, and
accurate when using a Tektronix sampling oscilloscope. The S-parameter wizard displays dialog boxes and messages to
guide you through setting up and acquiring the necessary TDR and TDT measurements. The wizard uses the TDR/T
waveforms and IConnect to generate S-parameter, Touchstone, Z-Line, and log files. You can load the files into IConnect or
other tools for further analysis or modeling.

NOTE. The S-parameter Wizard runs on Tektronix 8000 Series sampling oscilloscopes on which IConnect is installed, or
on a pC with IConnect installed and a GPIB or LAN connection to a Tektronix 8000 Series sampling oscilloscope. If the
oscilloscope or IConnect are not available, the S-parameter Wizard runs in demo mode. For other oscilloscopes, you will
need to manually acquire and save the necessary TDR/T waveforms and use the IConnect S-parameter computation
function to create S-parameter files. (See page 39, Manually Creating S-Parameter Files.)

Prerequisites
Follow measurement best practices. (See page 12, Measurement Best Practices.)

Differential measurements and long record acquisitions require that your signals arrive at the DUT at the same time.
Follow the deskew procedure in your oscilloscope manual, observe the difference in delays between the two channels in
differential mode, and adjust for half of that difference by using the delta TDR function in the oscilloscope.

1. Click the S-parameter Wizard button.

2. Select the measurement mode (number
of ports and type of measurement).

3. Assign the ports to the oscilloscope
channels. The S-parameter Wizard
labels the waveforms with the port
numbers.

4. Set the measurement parameters. The
fields displayed depends on the selected
measurement mode.

5. Click Start. The S-parameter Wizard
displays dialog boxes and messages
to guide you through setting up and
acquiring S-parameter measurements.
Follow the displayed instructions.
See the Data Files Saved topic in the
S-parameter Wizard online help for a list
of the output files generated for each
measurement mode.

6. Click Help to get more information
on setting parameters, using the
S-parameter Wizard, and the output files
generated for each measurement mode.
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NOTE. The S-parameter Wizard controls all oscilloscope settings during measurement sequences. Do not change any
oscilloscope settings while the S-parameter Wizard is running.

The S-parameter Wizard invokes a copy of IConnect in the background to generate the S-parameter, Touchstone, and
Z-Line waveform files.

NOTE. It is recommended that you use the S-parameter Wizard to acquire S-parameter waveforms for IConnect. The
S-parameter Wizard automates acquiring S-parameter waveform data, which significantly reduces the time it takes to
acquire data. The S-parameter Wizard also reduces the chance of errors in setting up the instrument or in forgetting to
take a set of port measurements.

Manually Creating S-Parameter Files
Frequency-domain scattering parameters (S-parameters) are a useful way to visualize the electrical properties of a system.
They are a dual representation of TDR and TDT data in the frequency domain. Although S-parameters have historically
been measured in the frequency domain using a network analyzer, you can use TDR and TDT measurements to obtain
differential and mixed mode S-parameter data.

S-parameter calculations require a reference waveform and a DUT waveform. The DUT waveform can be either a reflection
or transmission measurement.

Prerequisites
Follow measurement best practices. (See page 12, Measurement Best Practices.)

Set the oscilloscope to display the correct waveforms. (See page 13, Displaying the Correct TDR Waveform.)

Set IConnect to acquire the necessary waveforms. (See page 18, Acquiring, Saving, and Loading Waveforms.)

Differential measurements and long record acquisitions require that your signals arrive at the DUT at the same time.
Follow the deskew procedure in your oscilloscope manual, observe the difference in delays between the two channels in
differential mode, and adjust for half of that difference by using the delta TDR function in the oscilloscope.
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1. Acquire the necessary TDR and/or TDT
DUT and reference waveforms. The
number of waveforms to acquire depends
on the measurement mode (one-, two,
or four-port) and type (single-ended or
differential). See the Data Files Saved
topic in the S-parameter Wizard online
help for the number and type of DUT
and reference measurements needed for
each mode.

2. Load the S-parameter waveform files
into IConnect. (See page 18, Acquiring,
Saving, and Loading Waveforms.)

3. Click the S button to open the
S-parameter task tab.

4. Set the Source and Target waveform
viewers.

5. Select the DUT and Ref (reference)
waveforms in the Waveforms fields.

6. (Optional) Manually set the highest
frequency content parameters. If not
selected, IConnect calculates the highest
frequency content from the waveforms.
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7. (Optional) Use a 50 Ω calibration
waveform created using a precision 50 Ω
standard at the DUT reference plane.
You also have a choice between open,
short, and through reference calibration.
(See page 41, S-Parameter Calibration
Settings.)

8. Click the Compute button to open the
specified viewer and plot the S-parameter
values using the default display format
(dB (Mag)/Phase). Right-click in the
viewer and select Plot to view the data
in a different format (Magnitude/Phase
or Real/Imaginary).

S-Parameter Calibration Settings
In the Calibration settings, when Ref type is set to Thru, and DUT Type is set to Insertion loss/xtalk, IConnect ignores
the 50 Ω calibration waveform.

The Ref type field specifies what type of waveform to use in the waveform's Ref menu.

When Ref type is set to Open/Short, you must load a 50 Ω calibration waveform. To create a 50 Ω calibration waveform
for a two-port transmission measurement, remove the DUT and connect a reference 50 Ω termination to the port to
which the pulse will be applied from the TDR module, acquire and save the reflected waveform, and then enter that
file name in the Load 50 Ω Waveform field.

Differential and Common Mode Measurements
Differential (odd) and common (even) mode S-parameter measurements require different stimulus waveforms:

Differential mode measurements: The oscilloscope must have the two stimuli switching in opposite directions (180° out
of phase). For differential responses, subtract one response channel from the other.

Common mode measurements: The oscilloscope must have the stimuli switching in the same direction (in phase). For
common mode responses, add the two response channels together.
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True Impedance Profile (Z-Line) Measurement
The IConnect Z-Line impedance measurement analyzes the TDR waveforms to accurately determine the true impedance
profile of the device. An impedance profile lets you observe the type and position of discontinuities along a line. You can also
use the impedance profile for signal integrity modeling.

The impedance profile is the characteristic impedance of a PCB trace, package lead, or other transmission-line-type
structure, measured as a function of distance. Transmission lines tend to have multiple discontinuities which cause reflections
that superimpose on each other. TDR oscilloscope impedance measurements do not take these multiple reflections into
account, resulting in possibly significant impedance measurement errors for multiple-segment interconnects.

Z-Line impedance calculations require at least two TDR measurements:

A reference measurement of all connecting cables and/or probes without the DUT. If there are no interconnecting cables
or probes to the DUT, the reference measurement is to the connector on the TDR measurement module.

A measurement with all interconnecting cables/probes and the DUT.

Prerequisites
Follow measurement best practices. (See page 12, Measurement Best Practices.)

Set the oscilloscope to display the correct waveforms. (See page 13, Displaying the Correct TDR Waveform.)

Set IConnect to acquire the necessary waveforms. (See page 18, Acquiring, Saving, and Loading Waveforms.)

1. Acquire the appropriate waveforms from
the instrument or saved files. (See
page 18, Acquiring, Saving, and Loading
Waveforms.)

2. Click the Z button to open the Z-Line
Computation task tab.

3. Verify that Z-Line is already selected in
the Compute field.

4. Select the TD Waveform Viewer window
in which you acquired the waveforms in
step 1.
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5. In the Waveforms group, select the
measured DUT TDR waveform in the
DUT field, and the step waveform in the
Step field.

6. In the Parameters group, verify that the
Zo field (instrument impedance) is 50 Ω
(default).

7. Leave the Threshold field at 35%
(default).

8. Click the Compute button. IConnect
calculates the true DUT impedance and
adds the Z-Line plot to the TD Waveform
Viewer window.

Standard Modeling
IConnect and MeasureXtractor TDR software helps you extract many different types of interconnect models from
measurements. Model extraction in IConnect is a cooperative effort between IConnect’s underlying algorithms and the
different model viewers available for creating, editing, and saving various types of models. Models are accessible both from
the Model menu and from the Model toolbar buttons (toggled on or off from View > Toolbars > Model Toolbar).

Many of the model viewers have the ability to take measurements, extract a model, and validate it on your simulator, without
having to open another window. For more complex modeling tasks, you can cascade individual models by using the
editor in the Composite model viewer.

Model files are typically saved with .cir extensions, and may be loaded from the main menu using the File > Open command.
More typically, they are loaded from the Composite model viewer.
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Model Descriptions

Toolbar
icon Model Description

Source The Source model is an excitation model for launching an incident step into a DUT
model. The model parameters are step delay, step rise time, and step amplitude. The
delay is the time elapsed from t=0 before the ramp begins, and the risetime is the
0%-100% rise time of the ramp. The amplitude is that of the incident voltage step
injected into the DUT model, so in model verification applications it should be the same
as the step launched into the DUT during measurement. For example, ~200 mV for
HP TDRs, ~250 mV for Tektronix TDRs.
The Source model offers a quick, but less accurate, way to simulate a step input. The
accuracy is reduced because the sharp corners at the transitions are likely to inject more
high-frequency content into your DUT model than your real-world drivers will be injecting
into your DUT. Simulation results should be interpreted accordingly.

Piecewise-
Linear (PWL)
Source

The PWL (piecewise-linear) source model is an excitation model for launching an incident
step into a DUT model. The model consists of a set of time-voltage pairs, which describe
a time-domain voltage waveform. The data points from which the waveform is built
are defined through a graphical user interface, and are built from a measured voltage
waveform to accurately represent the excitation conditions present during measurement.

Lumped The Lumped model is built up from RLGC, RLC, RC, or LC sections. The LC sections
may be of pi, T, LC, or CL topology. The model may be used as a valid low-frequency
approximation to an ideal single transmission line, or as a model for electrically small
structures such as packages and connectors which are well represented by such a
topology.
The potential parameters to the model are the inductance L, the capacitance C,
the resistance R, and the conductance G. A picture shows graphically the selected
topology and how the R, L, G and C parameters are distributed in that topology. If a
more distributed model is desired, you may increase the number of subsegments, in
which case each of the values shown in the picture is divided by that number and the
subsegments are cascaded. Although this will not typically change the transmission
characteristics of your model, it will generally improve the reflection characteristics to
look more like those of a distributed transmission line.

Single Line The Single Line model consists of nonuniform cascaded RLGC and/or transmission
line sections, and is useful for characterizing structures that are well represented as a
single conducting path. Examples would be microstrip traces and some package leads.
The graphical user interface of the single line model editor determines the parameters
and topology of each of the sections, although R and G values must be determined
manually if desired.

Lossy Line As digital circuit speeds continue to rise, transmission line loss plays an increasingly
important role in signal integrity analysis. Transmission line loss is caused in large part by
two factors: skin loss in the conductors, and dielectric loss. The primary results are rise
time and amplitude degradation. Propagation delay becomes dependent on rise time,
and amplitude degradation becomes dependent on clock frequency and bit sequences.
The combination of these effects is eye closure at increased clock frequencies.
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Toolbar
icon Model Description

Passive
Equalizer

The Passive Equalizer model is built up from RLC or RC sections to model a passive
equalizer used in a communication channel. The model opens the eye by applying a high
pass filter characteristic (reducing signal loss at high frequencies) to the data stream of
the transmission line. The potential parameters to the model are the inductance L, the
capacitance C, and the resistance R. A picture shows graphically which topology has
been chosen, and how the R, L, and C parameters are distributed in that topology.

Two-port
Subcircuit

The Two-port Subcircuit model lets IConnect incorporate SPICE-based modeling results
into the overall model. Any SPICE model with input, output, and ground nodes may be
included as part of a composite IConnect model.
All two-port subcircuit node definitions must be in the following order: input node, output
node, and model ground node.

Lumped
Coupled

The Lumped Coupled models the crosstalk energy coupling between adjacent lines. The
signal propagating on the offender line transfers part of its energy onto the victim line.
The IConnect lumped coupled model is built up from RLCG, RLC, RC, or LC sections.
The LC sections may be of pi, T, LC, or CL topology. Because it models two structures
with inductive and capacitive coupling between them, it may be used as a valid
low-frequency approximation to an ideal set of two coupled transmission lines, or as a
model for electrically small coupled structures such as packages and which are well
represented by such a model.
The potential parameters to the model are the self and mutual inductance L1, L2, and
L12, and the self and mutual capacitance C1, C2, and C12, the resistance R, and the
conductance G. Although the picture in the modeling window shows the RLGC topology,
the various LC topologies available are equivalent to the analogous topologies shown in
the Lumped (uncoupled) model. If a more distributed model is desired, you may increase
the number of subsegments, in which case each of the values shown in the picture is
divided by that number and the subsegments are cascaded.

Symmetric
Coupled Lines

The Symmetric Coupled Lines model consists of nonuniform cascaded coupled RLGC
and/or transmission line sections, and is useful for characterizing structures that are well
represented as dual symmetric conducting paths. Examples are coupled microstrip
traces and some coupled package leads or connector lines. The graphical user
interface of the symmetric coupled lines model editor assists the user in determining the
parameters and topology of each of the sections, although R and G values must be
determined manually if desired.

Symmetric
Coupled Lossy
Lines

The Symmetric Coupled Lossy Line model allows you to simulate skin effect and
dielectric loss, together with intersymbol interference (ISI) and crosstalk effects. It
also allows you to predict the Eye Diagram degradation due to losses and ISI in the
interconnects. You may also incorporate Eye Diagram closure effects due to crosstalk
from neighboring line pairs.
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Toolbar
icon Model Description

Termination The termination model replicates the passive termination conditions of the DUT. The
only model parameter is resistance, since the model consists of a resistor to ground.
To emulate an open circuit, use a resistance value that is large compared to the
characteristic impedance, while for a short circuit, use a resistance value that is small
compared to the characteristic impedance of the measurement system. For a 50 Ω
system, for example, a typical open circuit termination resistance value would be 5k Ω
and a short circuit termination resistance value would be 1Ω.

Data Driven
Models (Single
and Coupled)

The data-driven models allow you to bypass any manual intervention in the modeling
process using IConnect’s MeasureXtractor modeling technology. IConnect supports
automatic model extraction for two-port and four-port models, which correspond
to single-line and coupled-line circuits. (See page 49, Advanced Modeling
(MeasureXtractor™).)
Data driven model extraction results in a SPICE netlist which very accurately replicates
the behavior of the measured device. The passivity of the model is guaranteed by the
extraction process. The resulting netlist cannot be adjusted, and will not be structurally
recognizable. As a result, you should not use data-driven models if you intend to adjust
parameters in the resulting model.

Example Standard Model Process

Prerequisites
Follow measurement best practices. (See page 12, Measurement Best Practices.)

Set the oscilloscope to display the correct waveforms. (See page 13, Displaying the Correct TDR Waveform.)

Set IConnect to acquire the necessary waveforms. (See page 18, Acquiring, Saving, and Loading Waveforms.)

1. Click the Lossy Line button.

2. Select the termination Type (Open or
Matched) on the Measure tab.

3. Click the buttons in the Select
Waveforms area to select and load the
required waveforms.
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4. Select the Model tab.

5. (Optional) Click the Options button and
set the Max. Iterations that IConnect
performs before calculations stop, and
the measurement Precision setting at
which to stop calculations (calculations
stop when IConnect reaches the
precision value setting).

6. Set the Lumped Model parameters.
Lumped Model settings affect how the
Lossy Line model is written to a file.
Enter a realistic rise time number
to decrease the required number of
subsegments for the model to be
accurate to that rise time. Alternatively,
you can manually decrease the number
of subsegments. You need to have at
least three segments per length of TDR
rise time.

7. Set the Netlist parameters. Netlist
settings affect how the Lossy Line
model is written to a file. Use the Scale
parameters by field to generate a
per-unit length model, or to easily scale
the length of the model.

IConnect® and MeasureXtractor™ Quick Start User Manual 47



Application Examples

8. Click the Compute button. IConnect
calculates the DUT Loss Parameter
characteristics and plots the simulated
waveforms.

9. (optional) Change one or more Loss
Parameter fields and click the Evaluate
button to test how different values
change the simulated waveforms. Use
the Fix check boxes to prevent the
current value from changing.

10. To save the model, right-click in the
waveform plot and select Save Model.

11. To view the model netlist, right-click in the
waveform plot and select View Netlist.

12. To simulate the model, select the
Simulate tab and click the Simulate
button. IConnect generates new viewer
windows as needed and prompts you to
enter the location at which to save the
simulation files.
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Model Extraction Tips
Keep models as simple as possible. Simple models are faster to simulate, easier to troubleshoot, and easier to
explain to a colleague or customer. One effective way to create a simple model is to filter your measured data prior to model
extraction to be sure that you are modeling for the rise time at which your circuit is intended to operate, and not modeling
an order of magnitude higher than necessary. Also, be certain that you are modeling your DUT, and not the parasitics
associated with your measurement system.

Work with models directly in the composite model viewer. Working directly in the composite model viewer will
save you the intermediate step of writing a model to disk and later having to reload it into the composite viewer for verification.

Know which models are most effective for which modeling tasks. Some assistance is available in the reference
material, but a certain amount of expertise must be gained through experience and through physical understanding of the
problem at hand. Tektronix is also available to give advice on modeling issues.

Make sure that your measured data is accurate. Your models can only be as accurate as your measurements, so
taking the time to do it right will pay off later. Ensuring that shorts are shorts, that opens are opens, and performing other
checks on measured data will save time and headache in troubleshooting later.

Advanced Modeling (MeasureXtractor™)
Whereas standard modeling provides an engineer with the tools to create a detailed topological model of an interconnect,
MeasureXtractor provides a fast way to create a data-driven model based on the measurements through a known good
interconnect. You can use this “black box” model in the IConnect Link Simulator to test and verify the interconnect
functionality. MeasureXtractor data-driven models let you simulate any interconnect structure, and include both time
dependent (reflection, ringing, crosstalk) and frequency dependent (frequency loss) interconnect behavior.

MeasureXtractor modeling can use time domain reflectometry and transmission (TDR/T) measurements or frequency
dependent S-parameter data. The size of the model is proportional to the interconnect size and complexity. The passivity,
stability and causality of the models are guaranteed.

Waveform Acquisition and Setup
Review measurement techniques if necessary. (See page 12, Measurement Best Practices.) In addition to the best practices
given in that section, it is particularly important when taking MeasureXtractor measurements to select a window that is long
enough to allow the DUT waveforms to completely settle to their steady state DC levels. High-frequency DUT analysis
requires the signal to settle to make an accurate analysis.

When to Use Data-Driven Models
Data Driven models are best used for devices which are electrically short or medium-sized. A rough rule of thumb is that the
device should be fewer than 20 wavelengths in length. Longer devices may take too long to extract. Another equivalent
rule of thumb is that the electrical length of the device shouldn’t be more than 100 times the rise time of the signal you will
use to excite the model. This is because the extraction time increases for waveforms with a large number of data points.
Furthermore, simulation time of the resultant model will also increase.

Prerequisites
Follow measurement best practices. (See page 12, Measurement Best Practices.)

Set the oscilloscope to display the correct waveforms. (See page 13, Displaying the Correct TDR Waveform.)
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Set IConnect to acquire the necessary waveforms. (See page 18, Acquiring, Saving, and Loading Waveforms.)

All the waveforms must be acquired with 50 Ω probes, fixtures, or cables connected to all the DUT ports.

The cables, probes, and fixtures used to connect the DUT to both channels of the TDR oscilloscope must be of the
same length.

Reference waveforms must be acquired at each port, with the cables, probes, and fixtures disconnected from the
DUT and left open-ended.

1. Determine the type of model that you
want to extract (single or coupled line).

2. Select the appropriate type model to
open the Data Driven viewers and task
tabs (the example shows the data-driven
Single Line Viewer and Task tabs).
You can also select the MeasureXtractor
model from the Model toolbar.

3. Select Time or Frequency domain
data for MeasureXtractor data driven
modeling. The parameters displayed
depend on the selected domain type.
If you select Time domain, you can
acquire the data directly from a TDR
oscilloscope, load saved waveform files,
or select waveforms from an open Viewer
window. If you select Frequency domain,
you will need to acquire and save the
waveform data as frequency-dependent
Touchstone files beforehand, with port 1
(and 3 for coupled line) as inputs, and 2
(and 4 for coupled line) as outputs.

4. Load or acquire the necessary
waveforms for each port.
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5. Select the Model tab and click the
Extract button. The Results area lists
the number of poles and any errors
encountered during the extraction.

6. To save the model, right-click in the
TDR/T viewer and select Save Model.
Use the Syntax field in the Save
dialog box to set the model file syntax
(variations on SPICE, or the IConnect
Linear Simulator).

7. To view the model netlist, right-click in the
TDR/T viewer and select View Netlist.

8. To simulate the model, select the
Simulate tab and click the Simulate
button. IConnect generates and displays
associated viewers during the simulation,
and also prompts you for the location to
store the simulation results.
The simulator specified in the
Tools/Options menu on the Simulate
tab must match the Syntax field entry in
step 6.
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9. If you need to increase the precision
with which IConnect models the TDR
reference port data, open the appropriate
PWL Source window, decrease the
Max Error value and click Partition to
repartition the PWL Source model. Make
sure to save it before continuing.

10. After the simulation is complete, the
simulated waveforms are placed in the
Composite model waveform viewers.
Click the TDR/T or S(f) tabs to view the
correlation. The correlation is exact in
both time and frequency domains.
When using Touchstone files, note that
IConnect uses ports 1 and 3 as the input
ports, and ports 2 and 4 as the output
ports. Use the Port Mapping option when
reading the Touchstone file if the file
uses a different port numbering scheme.

See the Online help for more information on MeasureXtractor functions and the Model Composite Editor.
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Index

Symbols and Numbers
1-port differential setup, 11
1-port single-ended setup, 10
2-port differential setup, 11
2-port single-ended setup, 10
4-port single-ended setup, 11

A
Acquire waveforms from

oscilloscope, 18
Acquiring, Saving, and Loading

Waveforms, 18
Advanced Modeling

(MeasureXtractor), 49
Algorithm toolbar, 5, 6
Align DUT waveforms (EZ Z-line), 7
Application examples

creating custom standard-based
Eye Diagram test, 28

Eye Diagram compliance
test, 24

Application Examples
S-parameter Wizard, 38

Apply a low pass filter, 7
Autoscale waveform plot, 8
Auxiliary toolbar, 5

C
Calibration toolbar, 6
Change viewer waveform properties

(color, label, cursor readouts,
S-parameter), 7

change waveform plot units, 8
Comparing DUT Z-Lines to a

reference DUT, 32
Compliance information, ii
Compliance testing, Eye

Diagram, 24
Connecting the DUT, 10
Convert S-parameter waveform, 7
Create a golden setup file (EZ

Z-Line), 33
Create a waveform label, 7
Create a waveform view label, 8
Creating a custom Eye Diagram

test, 28, 30

Cursor view, 5
Cursors and cursor readouts, 9

D
Data-driven models model

description, 46
Delete a waveform, 7
Device under test (DUT)

connections, 10
Differential and common

measurements, 41
Display correct TDR waveform, 13
Display waveform in Spectrum

view, 7
Drag-and-Drop waveforms or

files, 21
DUT setups, 10

E
Enhanced Accuracy mode (long

records), 12
Environmental considerations, ii
Equipment recycling, ii
Evaluation version, 1
Example standard model

process, 46
Execute oscilloscope commands

from a file, 22
Export to Touchstone format file, 8
Export waveform data, 7
export waveform to a csv file, 22
Export waveform to a Touchstone

file, 22
External monitor (optional), 1
Eye Diagram compliance test

caveats, 30
Eye Diagram tests

compliance testing, 24
creating custom nonstandard

based, 30
creating custom standard-based

tests, 28
nonstandard based, 30

EZ Z-Line DUT testing, 32

F
File Operations

execute oscilloscope
commands from a file, 22

export waveform to a csv
file, 22

export waveform to a
Touchstone file, 22

load oscilloscope settings from
a file, 22

restore oscilloscope settings
from a file, 22

run oscilloscope commands
from a file, 22

Save a single waveform, 22
save oscilloscope settings to a

file, 22
Save waveforms to a new

location, 22

G
Generating S-parameter files, 39
GPIB board, 1
GPIB settings, 3
GPIB/USB interfaces, 4

H
Hardware key (dongle), ii, 2
Hide a waveform, 7

I
Impedance versus frequency

waveform, 7
Import waveform or data into a

view, 8
Import waveform or other data into

the view, 8
Installation (requirements and

procedure), 1
Installing IConnect software, 1
Integration and differentiation

(waveform math), 23
Interface, 3
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K
Key features, iii

L
Label a waveform, 7
Label a waveform view plot, 8
LAN interface, 3
Load oscilloscope settings from a

file, 22
Load saved waveforms into

IConnect, 21
Lossy Line model description, 44
Lumped Coupled model

description, 45
Lumped model description, 44

M
Maximum version, 1
Measurement best practices

adequate waveform record
length, 13

deskew channels, 13
Display correct TDR

waveform, 13
Make good connections to

DUT, 11
observe electrostatic prevention

guidelines, 13
use signal averaging, 13
Warm up the oscilloscope, 12

MeasureXtractor, 49
Memory requirements, minimum, 1
Menu Bar, 5
Minimum system requirements, 1
Minimum version, 1
Model descriptions

data-driven models, 46
Lossy Line, 44
Lumped, 44
Lumped Coupled, 45
Piecewise-Linear (PWL)

Source, 44
Single Line, 44
Source, 44
Symmetric Coupled Lossy

Lines, 45
Termination, 46
Two-port Subcircuit, 45
XXX, 45

Model extraction tips, 49

Model toolbar, 6
Move a waveform, 7

O
Operating basics, 5
Optional external monitor, 1

P
Passive Equalizer model

description, 45
Piecewise-Linear (PWL) Source

model description, 44
Pop-up function descriptions, 10
Product end-of-life handling, ii

R
Reset waveform position, 7
Restore oscilloscope settings from a

file, 22
Run IConnect on a Tektronix

oscilloscope, 2
Run oscilloscope commands from a

file, 22

S
S-parameter computation, 38
S-parameter files, generating, 39
S-parameter toolbar, 6
Save a single waveform, 22
Save a waveform, 7
Save oscilloscope settings to a

file, 22
Save waveforms from

oscilloscope, 20
Save waveforms to a new

location, 22
Select a waveform, 7
Set waveform view horizontal and

vertical scales, 8
show all waveform traces in plot, 8
Show or remove a cursor readout, 7
Single Line model description, 44
Software versions

Evaluation, 1
Maximum, 1
Minimum, 1
Standard, 1

Source model description, 44

Standard Modeling, 43
Standard toolbar, 5
Standard version, 1
Starting and stopping the

application, 2
Status Bar, 5
Supported instruments, iii
Supported operating systems, 1
Symmetric Coupled Lossy Lines

model description, 45
System requirements, minimum, 1

T
Task tabs, 5, 9
TekVISA, 1, 2, 3
Termination model description, 46
The Status Bar, 10
The user interface, 5
The Waveform/Data views, 6
Tool Bar, 5
Toolbar, 5
Touchstone, 8
True impedance profile (Z-Line)

measurement, 42
Two-port Subcircuit model

description, 45

U
Undo zoom or Autoscale

operation, 8
Using EZ Z-Line, 35

W
Waveform Math, 23
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Waveform trace operations
align DUT waveforms (EZ

Z-line), 7
apply a low pass filter, 7
change waveform properties

(color, etc.), 7
convert s-parameter

to impedance vs.
frequency, 7

create a waveform label, 7
delete a waveform, 7
display a cursor readout, 7
display waveform in Spectrum

view, 7
export waveform data, 7
hide a waveform, 7
label a waveform, 7
move a waveform, 7
remove a cursor readout, 7
reset waveform position, 7
save a waveform, 7
select a waveform, 7
show a cursor readout, 7

Waveform view operations
Autoscale, 8
change waveform plot units, 8
create a waveform view label, 8
export to Touchstone format

file, 8
import waveform or data into a

view, 8
label a waveform view, 8
set waveform view horizontal

and vertical scales, 8
show all waveform traces in

plot, 8
undo zoom or Autoscale

operation, 8
zoom on region, 8

Waveform/data views, 5

Z
Z-Line DUT testing, 32
Zoom on waveform region, 8

IConnect® and MeasureXtractor™ Quick Start User Manual 55


	IConnect and MeasureXtractor Signal Integrity, TDR, and S-parameter Analysis Software Quick Start User Manual
	Table of Contents
	Compliance Information
	Environmental Considerations

	Preface
	Key Features
	Documentation
	Conventions Used in This Manual

	Installation
	IConnect Software Versions
	Minimum System Requirements
	Installing Software
	Starting and Stopping the Application
	Running IConnect on a Tektronix Oscilloscope
	Running IConnect on a PC

	Operating Basics
	The User Interface
	Connecting the DUT
	Measurement Best Practices
	Displaying the Correct TDR Waveform
	Acquiring, Saving, and Loading Waveforms
	File Operations
	Waveform Math

	Application Examples
	Eye Diagram Compliance Testing
	EZ Z-Line DUT Testing
	Automatically Creating S-Parameter Files (S-Parameter Wizard)
	Manually Creating S-Parameter Files
	True Impedance Profile (Z-Line) Measurement
	Standard Modeling
	Advanced Modeling (MeasureXtractor™)



